HarryT's Book Designer Tutorial

Version 1.0: 8th Apr 2007

This illustrated guide shows, step by step, how I create a nicely formatted Sony Reader book from a "Project Gutenberg" file using the free "Book Designer" tool, hereafter referred to as "BD". There are many ways to do create a book, and I wouldn't claim that my way is the best, but it's what I've evolved over time and it works for me.

The guide assumes that you have the latest version of Book Designer installed on your computer; please see elsewhere on the "MobileRead" forums for information on how to obtain and install the current version.

This guide is not in the public domain, but I, the author, grant permission for it to be freely distributed, without charge, for non-commercial use.

Steps in Creating a Book

These are the steps I take when creating a book. Each will be expanded on in detail below, but this is the main "check list" I work with. It's useful to follow a consistent sequence of steps to ensure that nothing is left out.

1. Choose your book format.

2. Assemble all the files in a folder.

3. Load the file into BD and make sure the language is correct.

4. Delete unnecessary text.

5. Add the title page and an empty table of contents.

6. Format the chapter headings.

7. Remove unnecessary styles.

8. Format "marked" text.

9. Format any other text with special requirements.

10. Add a table of contents.

11. Add footnotes.

12. Create your book.

13. Save the files for subsequent use.

Step 1: Choose your book format.

OK, so you've gone to the main Project Gutenberg page at:

http://www.gutenberg.org
and searched for your book. Throughout this tutorial I'm going to use an H. Rider Haggard book called "Black Heart and White Heart", because it's a reasonably short book (a novella), which has all the features in it that I want to illustrate. When we've found the book on PG we're presented with a choice of formats to download, as shown below:
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Which format should we select?

There are three main types of book on Project Gutenberg (PG). In descending of "desirability" these are:

1. HTML. If an HTML version of a book is available, use it. It will generally have decent formatting, bold and italic text where appropriate, links to footnotes, etc. HTML will save you a lot of work!

2. 8-bit text. This will generally be described on the "Encoding" column as "ISO-8859-1" which means that it contains "accented" letters. This is good!

3. 7-bit ASCII text, described as "US-ASCII". Select this where nothing else is available.

For the purposes of this tutorial, even though an HTML version of my example book, "Black Heart and White Heart" is available, I'm going to download the ISO-8859-1 plain text version, because it will allow me to illustrate all the formatting steps. So, on the screen above, on the line for "ISO-8859-1" encoding with no compression, I right click the "main site" link and select "Save Target As", and when the "Save" dialog appears, I save the file as "Black Heart and White Heart.txt". If you want to download the book directly, to "work along" with this tutorial, the direct download link is:

http://www.gutenberg.org/files/2842/2842-8.txt
You can, of course, view the file in your web browser and then save it from there if you wish. However you do it, you should end up with a text file called "Black Heart and White Heart.txt" on your hard disk.

Step 2: Assemble all the files in a folder

Create a folder on your hard disk, and put in there all the files you're going to need for the project. I prefer to use a "hierarchical" directory structure for my e-Books, something like:

C:\

  EBooks

    Haggard, H. Rider

      Black Heart and White Heart

Ie to sort them by author, and for each author, have a separate folder for each book. So, create whatever folder structure you wish, and copy the downloaded file into there. We'll also use this folder to store the final Sony Reader file, and BD's "working files" which will allow us to do more work on the book in the future.

What other files might we need? Personally I like to have a picture of the author on the title page of the book; you might like other "cover art" – perhaps a picture of the book cover. Whatever "art work" you want, put the files for it into your folder along with the book.

One "tip", by the way: if, like me, you want to put a picture of the author on the book's title page, you'll generally find one on the "Wikipedia" article about the author. So, in this case, we go to:

http://www.wikipedia.org
and search for the article on Henry Rider Haggard. We get:
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which has a nice picture. So, right click on the picture, select "Save Picture As…" and save it as, say, "author.jpg" in our working folder.

Step 3: Load the file into BD and make sure the language is correct

Once we've collected all our files together, we've now in a position to start work, so load the file into BD. There are two ways to do this:

1. Run BD and then use the "File/open book" menu command to locate and open the book file.

2. Right click the book file in Windows Explorer, select "Open With…" and choose "Book Designer" from the list of applications.

Whichever of these methods we choose, we should end up with the following:
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this is a complete "mess" but is our starting point for creating a great-looking book for the Sony Reader.

Attached to the right side of the window is a separate tool palette – the "Corrector" palatte:
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this is very important indeed in BD and is where we do most of our work.

Before we start work on the book, there's something very important we have to do – change the book language.

Look at the bottom left of the BD window and you'll see a panel on the status bar saying "English". You may think that this is right (it is, after all, an English book), but you'd be wrong! Because our file contains "accented" letters, BD's default language setting of "English" messes these up and replaces them with Russian characters (BD is a Russian program). What we need to do, therefore, is fool BD into thinking that we are using a language which contains those accented letters, so it will represent them correctly.

What we do, is this:

Click the "Settings" button. This is the third button up from the bottom in the middle row of the "Corrector" tool palette – the one with the picture of a screwdriver on it. This will display the "Settings" screen:
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Go to the "book language" drop-down list at the bottom left, and change the setting from "English" to "French" – French is a language which contains all the accented letters we need. While we're here, you may want to change the other settings to match what's shown above – in particular clear the "play sounds" box; this turns off BD's "gunshot" sound effects.

Once you've changed the language setting, click the "reload file" button at the bottom of the dialog. The dialog will disappear, the file will be reloaded (this time with all the accented letters appearing correctly) and BD's status bar will display "French".

We can now start work on the book.

(By the way, if you want to stop at any time, simply click the "Save" button on the top toolbar – the button with a picture of a floppy disk on it. This will save your working file; the next time you start BD it'll re-load automatically.)

Step 4: Delete unnecessary text

The next thing to do is to get rid of unnecessary text at the start and end of the file. BD has tried to be "helpful" and guess what the book's title and author are, but it's got it completely wrong.

In the case of the PG book, there will generally be "licence" information both at the start and at the end of the book. We don't need these for our Sony Reader version.

We navigate around BD just like a word processor, and the usual "shortcuts" work – eg "Ctrl+Home" takes you to the start of the book, and "Ctrl+End" to the end.

Click on the BD window, and select the initial text that we don't want – everything above "DEDICATION":
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Press the "Delete" key on your keyboard to get rid of it:

Now, press "Ctrl+End" to go to the end of the book, and you'll see several pages of legal stuff. Page up several pages until you find the line saying:

End of Project Gutenberg's Black Heart and White Heart, by H. Rider Haggard

Then select and delete everything below that. Press "Ctrl+Home" to return to the start of the book.

Step 5: Add the title page and an empty table of contents

Now, manually type in the text you want to appear on the title page, leave a few lines blank, and then type the word "Contents", followed by a few more blank lines, as shown:
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I like to add a publication date to my title page, as shown.

Now, apply the appropriate formatting to these:

1. Select the title, and click the "book title" button in the "Corrector" palette.

2. Select "by", go to the "Format" menu on the menu bar, and select "more transformations", then "align: center" to centre the line.

3. Select "H. Rider Haggard" and click the "book author" button on the "Corrector" palette.

4. Select the "First Published 1900" line and centre it, as in step 2 above.

5. Select the "Contents" line and click the "title" button on the Corrector palette.

The resulting screen should now look like:
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which is a lot nicer!

Next, we want to add some manual page breaks. The "page break" button is to 4th button up from the bottom in the left column of the Corrector palette and is intended to show two separated pages.

Position the cursor between the "First Published" and "Contents" lines, and click the "Page Break" button; a line should appear across the screen to show the page break. Position the cursor just above "DEDICATION" and repeat this. The result should be:
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The final thing I now do on the title page is to add my author picture. In Windows Explorer, navigate to the folder where you've stored your picture, and drag and drop it to one of the lines between "First Published" and the page break. It should appear on the page; scroll down a bit so you can see it properly:
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The picture will probably not be the size we want it – the one above is a little large, so double click it; an "Insert/Edit Picture" dialog will appear:
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You can experiment with different sizes by changing the "Width" field (the height will change authomatically) and click the middle "Insert" button at the bottom of the dialog to see the effect. In my case, I reduce the size from 110.5% to 100%, and click "Insert" to get the final effect. My title page is now complete.

[image: image12.png]% Black Heart and White Heart

Fle Edt Fomat Insert View Go Tools Convertors Makeeooks Configuration Help

B &(0(Q|@| o[ e a(w)sl bol] 29| @)0]@]|e | /)|

Black Heart and White Heart
by

H. Rider Haggard

Fisst Published 1900

French | 41 pages




Obviously you can add whatever text, graphics, etc, that you wish to the title page. This is just my style – try something different if you wish! The vitally important thing is that the book title and author are given the correct styles, because this is information which gets picked up later when we create the final book.

Step 6: Format the chapter headings

The next thing to do is to format the chapter headings. First, a word about "styles" in BD. The Corrector palette has a list of the available styles in the text buttons starting at the top right. We've already applied a few of these – "book author", "book title", and "title".

"title" is the most important of these styles because:

1. A "title" style will (generally at least) for a page beak in the final book.

2. Everything with the "title" style ends up as an entry in the "Table of Contents" page of Reader for that book.

3. If you switch on "footers" in the final book, the most recent "title" text appears as the footer text.

What I do, therefore, is to keep the "title" style exclusively for chapter headings, and for anything else I want to end up on the "Table of Contents" page of the Reader. BD will try to be "smart" and decide what should be a title, but it often gets it wrong – we'll deal with that later.

What we're going to do now is to page down through the book, and re-type all the chapter titles ourselves, deleting the original ones.

Why do we do this?

If you page down through the book you'll find the first chapter heading a couple of pages down:
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(We also have a repeat of the book title here – we delete these lines).

What BD has done, as can be seen from the colour coding, is make "CHAPTER I" the title. The actual chapter name:

PHILIP HADDEN AND KING CETYWAYO

Is in a lighter shade, which is actually the "subtitle" style, which we don't want to appear in our book, because it messes up the footers. With BD's default settings all we'll get in the "Table of Contents" in the final book is:

CHAPTER I

CHAPTER II

Etc

Which is both ugly and extremely unhelpful. What I prefer to do, therefore, is to re-type the chapter headings, miss out the word "Chapter" (the Reader's screen is small, so it's just wasted space on the TOC page) and use mixed case. What I therefore do, for each chapter heading is to first type it as text immediately above the original chapter heading:
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then delete the original text, and finally select my text and click on the "title" button in the Corrector palette to make it a title, resulting in:
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At the date of our introduction to hi, Philip Hadden was a ransport-rider end trader in "the Zulu." Sill on the right side of forty,
in appeatance he was singulady handsome; tall, dark, upright, with keen eyes, shori-pointed beard, culing heir and clear-cut
Features. His ife had been varied, and there were passages in il which he did not natate even Lo his mostintimate friends. He was of
gentle birth, however, endl i was Said that he had received a public school and university education in Englend. At any rate he cold
quote the classics with aptitude on occasion, an accomplishment which, coupled with his refined voice anla bearing not altogether
commonin the wild places of the world, had eamed for him among his rough compenions the soubriguet of "The Prince."

However these things may heve been, i is cerlein that he had cnigrated to Natal under o cloud, end equally cerlein that his
selaives ot home were content to take no further interest in his fortunes. Duting the fifteen or sixteen years which he had spent in or
about the colony, Hadden followed many trades, and did no good at any of them. 4 clever man, of agreeable and prepossessing
mannes, he always found it casy to form friendships and to secue a fresh start in ife. But, by degrees, the riends were seized with o
vague distrust, of hin and, afler a period of more or less application, he himself would close the opening that he had made by o
sudden disappearance fiom the locality, leaving behind him a doubiful feputation and some bad debs.

Before the beginning of this story of the most remarkable episodes in his lfe, Philip Hadden was engeged for several years in
transport-ridingthat s, in carrying goods on ox waggons from Dusban or Martzburg Lo various points in the interior. 4 difficulty
such as had more then once confronted him in the cousse of his career,led 1o his temporary ebandonment of this meens of earning &
livelihood. On ariving et the litle frontier town of Utrecht in the Transvaal in charge of two wazgon loads of mixed goods

French | 41 pages





I leave two blank lines before and after the title – this spaces nicely in the Reader.

Page through the book and do this for all the chapter headings. There are only 6 in this short novella, but some books have 50+ chapters, so it can take a while to do! In this book I've also done the same for the "Author's Note" immediately above chapter 1, and added a manual page break because it would otherwise appear on the same page as the "Dedication", which we don't want to happen.

Step 7: Remove unnecessary styles

BD will, as I've said above, make a guess about what styles different things should be in. Very often, when it comes across something that's on its own on a page it'll make it a "title" or a "subtitle" style. We don't want this, because it messes up the Table of Contents, and the book footers, and every time you have a "title" style you'll get a page break in the finished book.

There is a very useful tool in BD which will let us look for such anomalies, the "element browser". To display this, go to the "Tools" menu and select "Element Browser". Select the type of thing you want to find (initially "titles") and click the "Find" button. We see:
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This is actually pretty much OK. The only thing that really shouldn't be a title is the DEDICATION line. Very often,  though, you'll see all sorts of stuff in the list that really shouldn't be there.

First, uncheck the "auto refresh" button; it makes it almost impossible to type anything in BD if this is selected. Now, move the Element Browser so it doesn't obscure the corrector palette, and click, in turn, each item that shouldn't be a title – in this case, that's just the DEDICATION line. BD will scroll to the text, and highlight it:
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I don't want the word "DEDICATION" to be a title, but I do want it to be centred text, so first I click the "paragraph" style button on the Corrector palette – "paragraph" is the style of normal text. Next, I select "Format/more transformations/align: center" to centre the text on the line. This leaves the text looking pretty much the same, except that it's now no longer the title.

I'm going to take this opportunity to cut and paste the dedication and move it up so it immediately follows the title page, above the currently-empty title page, and also reformat it a bit. The end result is:
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You have to use your judgement with these things – I think that the above looks quite nice; you may not, of course!

Having sorted out the titles, we now do the same for subtitles. In the Element Browser, select "subtitles" from the drop-down. You'll now see:
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This book uses "*****" to indicate a scene change, and BD has made them all into subtitles. We don't want this, because these will all appear in the footer text if we leave them like that. So, for each other, click on it to select it in BD, then go to the Corrector palette, click "paragraph", then centre the text as before using the "Format" menu. The result should be an empty list of subtitles.

Step 8: Format "marked" text

This is, I'm afraid, the (very) tedious part of the process.  Many PG text files indicate italic text either by enclosing it in "_" characters, or by enclosing it in "/" characters. Thus:

"_you've done what?_", he said

and:

"/you've done what?/", he said

would both indicate that the original text contained:

"you've done what?", he said

This is the reason to choose an HTML original, if at all possible; it will have all the original formatting in and this step can be omitted. Here, though, we've got to do these replacements to make the book look good.

Press "Ctrl+Home" to go the start of the book, then go to the "Edit" menu and select "find/replace". The "Find/Replace" dialog will appear:
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First, enter "/" into the "find" field, as shown, as press "find" (or the F3 function key). There are no matches, so this book doesn't use "/" to indicate italics.

Now enter "_" into the "find" field and click "find" again. This time we do get a match:

[image: image21.png]% Black Heart and White Heart

Fle Edt Fomat Insert View Go Tools Convertors Makeeooks Configuration Help

B S0E|@ olct|¢| ADjE bos| 2|

pemission to hunkfor b L asket and men 1 0 it e, then whom 610 pedhass e con bt on th matis 1ot 1 vl
bidthe king farewsl, and joueney to Natal

"In order o make report of what he has seen and leamed hete,” muttered Cetywayo

A this moment the talk was interrupted, for the soldiers who had led away the old Induna retuened at speed, and prostrated
themselves before the king.

15 e dead?" he asked.

"He has travelled the king's bridge," they answered grinly, *he died singing a song of praise of the king "

"Good," said Cetywaya, “that stone shall urt my feet no moe. o, tllthe tale of s casting away to Sompeeu and to the Queer's
Indunain Natal" he added with bitter emphasis

“Babal Hear ou Father speak Listen to the umbling of the Elephant,” said the Indunas taking the point, while one bolder then
the sest added:

"Soon we vill el them another tale, the white Talking Ones, a red tale, a tale of spears, and the regiments shal sing it in their

A the words an enthusiasm caught hold of the listeners, as the sudden flame catches hold of dry grass. They sprang up, for the
most of them were seated on their haunehes, and stamping their feet upon the grovad in unisan, repeated: lindaba tbomun indaba
ye nikonto Lizo dunyiswa nge impi ndhleben yaho. _ (A ted talel A red talel A tale of spears, And the _impis_shall sing it in their
cars) One of them, indee, & great ferce-Face fellow, drew near to Hadden and shaking his ist before s eyes-fortunately being in
the zoal presence he had o assegai-shoted the sentences at him

The king saw that the fre he had it was burning too fercely.

"Silence," he thundered in the deep voice for which he was remarksble, and instantly each man became as i he were tumed to
stone, anly the echoes still answwered back: And the impis shal sing it in thei ears-in their eare."

"1 am growing certain that this is no place for me,” thought Hadden;

"iFthat scoundrel had been amed he night have temporarly forgotien hinself Hullol who's this?”

Just then there appeaed through the gate of the fence a splendi specimen ofthe Zul race. The man, who was sbout thiry-five
years of age, was amrayed in a full war dhess of & captain of the Uity segiment, From the ciclet of ofte skin on his brow 10se his
crest of phimes, zound his middle, ams and knees hung the long finges of black oxtail, and in one hand he bore & tle dancing
shield, also black in colou. The other was empty, since he might not appeat before the king bearing ams. In countensnce the man
was handsome, and though fust now they betzayed some aniety, his eyes were genial and honest, and his mouth sensitive. In
height he must have measured six foot two inches, et he did not stike the observer as being tal perhaps because of his width of

French | 41 pages > wier s





An entire sentence is between "_" characters (this book uses italics to mark text that's in the Zulu language). What we have to do, therefore is:

1. Highlight the text that's between the underscores (it's easiest to use "shift" and the arrow keys to do this).

2. Press "Ctrl+I" (or "Format/Italic") to make the text italic.

3. Delete the underscores.

The result is:
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themselves before the king.

15 e dead?" he asked.

"He has travelled the king's bridge," they answered grinly, "he died singing a song of praise of the king "

"Good," said Cetywayo, "that stone shall hurt my fect no more. Go, tellthe tale ofis casting away to Sompseu and to the Queer's
Induna inNatel " he added with bitter emphasis

“Baba! Hear our Father speak. Listen to the runibling of the Elephant," said the Indunas taking the point, while one bolder than
the rest added:

"Soon we wil tell them another tale, the white Talking Ones, a red tale, = tale of spears, and the regiments shall sing it in their

At the words an enthusiasm caught hold of the listeners, o5 the sudden flame catches hold of dry grass. They sprangup, for the
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"I am growing certein that this s o place for me," thought Hadden;

"if that scoundel hedl been amed he might have temporarly forgotien himsef. Hullol who's this?"
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Now, press "F3" again to find the next occurrence of an "_" character, and repeat. There can be many hundreds of such occurrences in a long novel and this can, therefore, take several hours to do. If anyone knows a way to automate it, I'd love to know! To repeat, you don't have to do this if you start off with an HTML original.

This book only contains a few dozen occurrences and it takes only a few minutes to put in all the italics.

Step 9: Format any other text with special requirements

Next, we return to the original text file we started out from, and quickly page through it (eg in "Notepad") to see if there's any text that could do with "special" formatting to make it look good. BD "flows" text onto a single paragraph and will often, therefore, lose the formatting of things like letters in the original text where the "greeting" line should really be a separate line from the body of the letter. If you want anything, go to the corresponding place in the text in BD, and reformat accordingly.

In this book, the only thing I can spot is a fragment of singing in chapter I:
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safd the Indunas taking the point, while one bolder than the rest added
"Soon we will tell them another tale, the white Talking ones, a red
tale, a tale of spears, and the regiments shall sing it in their ears.”

it the words an enthusiasm caught hold of the Tisteners, as the sudden
Flame catches hold of dry grass. They sprang up, for the most of them
were seated on their haunches, and stamping their feet upon the ground
in unison, repeated:

_tndaba fbomwu--indaba ye mikorto

Lizo dunyiswa nge fmpi ndhlebeni yaho._
Ca'red tale! A red tale! A tale of spears
And the “impis_ shall sing it in their ears.

one of them, indeed, a great fierce-faced fellow, drew near To Hadden
and shaking'his fist before his eyes--fortunately being in the roya
presence he had no assegai--shouted the sentences at him

The king saw that the Fire he had 19t was burning too Fiercely.

"silence,” he thundered in the deep voice for which he was remarkable.
and instantly each man became as it he were turned to stone, only the
echoes sti11 answered back: "and the _impis_ shall sing it in their
ears—-in their ears.”

" _am growing certain that this is no place for me,” thought Hadden:
"if that scoundrel had been armed he might have temporarily Forgotten
himself. Hullol who's this?"





When we locate this text in BD we find that BD has "flowed" this in-line with the text (the "Edit/Find" function we used in the previous step is very useful for this) – it is, in fact, the first example of the "italics" that we came across above.

We add carriage returns to separate it out into its original lines, and then just as a final touch, select it and give it the "verse" style in BD which indents it slightly and displays it in italics, which looks a lot nicer:
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"He has travelled the king's bridge," they answered grinly, "he died singing o song of praise of the king "

"Good," said Cetywayo, "that stone shall hurt my fect no more. Go, tellthe tale ofis casting away to Sompseu and to the Queer's
Induna inNatel " he added with bitter emphasis

“Baba! Hear our Father speak. Listen to the runibling of the Elephant," said the Indunas taking the point, while one bolder than
the rest added:

"Soon we wil tell them another tale, the white Talking Ones, a red tale, = tale of spears, and the regiments shall sing it in their

At the words an enthusiasm caught hold of the listeners, o5 the sudden flame catches hold of dry grass. They sprangup, o the
most of them were seated on their haunches, and stamping thes feet upon the ground in unison, repeated-

Indaba bomwiindaba ye mikonto
Lizo duanpiswa nge tmpi ndhiebeni yaho.
(Ared tale] Ared tale! A tale of spears,

And the impis shall sing it in their ears.)

One of them, indeed, o great fetce-faced fellow, deew s to Hadden and shaking hisfst before his eyes-fortunalely being n the
toyal presence he had 1o assegai-shoted the sentences at him,

The king saw that the fre he had it was burning too fercely.

"Silence," he thundered in the deep voice for which he was remarksble, and instantly each man became as i he were tumed to
stone, anly the echoes still answwered back: And the impis shal sing it in thei ears-in their eare."

"1 am growing certain that this is no place for me,” thought Hadden;

"iFthat scoundrel had been amed he night have temporarly forgotien hinself Hullol who's this?”

Just then there appeaed through the gate of the fence a splendi specimen ofthe Zul race. The man, who was sbout thiry-five
years of age, was amrayed in a full war dhess of & captain of the Uity segiment, From the ciclet of ofte skin on his brow 10se his
crest of phimes, zound his middle, ams and knees hung the long finges of black oxtail, and in one hand he bore & tle dancing
shield, also black in coloue. The other was emiy, since he might not appeer before the king bearing ems.In countenance the man
was handsome, and though fust now they betzayed some aniety, his eyes were genial and honest, and his mouth sensitive. In
height he must have measured six foot two inches, yet he did not stike the observer as being tal, perhaps because of his width of
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Again, this process can take a while, and you'll probably miss something in your original pass through the book. Book creation is a process of continual improvement – ask your readers to spot any formatting mistakes for you.

Step 10: Add a table of contents

The next step in the process is to add a nice "Table of Contents". I'm not talking here about the "Table of Contents" page on the Reader – BD creates that for us automatically from the "title" styles, but rather a "text" table of contents at the start of the book, like a printed book has.

You'll recall that, right at the start, we left a blank page for our contents page. Go back and find that now:
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savagery and death,

H. Rider Haggard.
Ditshingha.

Author's Note

Of the three stories that comprise this volume[*], one, "The Wizszd,”  tale of victorious fath, first appeared some years ago as a
Christmas Anmual. Anothes, "Elissa" is en ltempl, difficult enough owing to the scantiness of the material 1oft o us by time, to
secteate the ffe of the sncivnt Phoenician Zinbabwe, whose riins stll stand in Rhodesia, and, with the addition of the necessary
fove story, to suggest cizcumstances such as might have brought about or accompanied its all at the hends of the sunounding
savage tribes. The third, "Black Heart and White Heart," s a story of the courtship,tisls and final union of a pai of Zult Iovers in
the time of King Cetyway.

[¥] This text was prepared from a volume published in 1900 tiled "Black Heart snd White Heart, and Other Stories." JE.
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We'll start off by typing in the chapter titles. Once again, the "Element Browser" can be a big help with this. If it's not already visible, select "Tools/Element Browser" to display it, and find all the titles. Position the Element Browser window alongside the main BD window, and clear the "auto refresh" check box in the browser window so it doesn't interfere with out typing in the main window. Using the Element Browser window as a reference, type in the chapter titles:
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Author's Note

Of the three stories that comprise this volume[*], one, "The Wizszd,”  tale of victorious fath, first appeared some years ago as a
Christmas Anmual. Anothes, "Elissa" is en ltempl, difficult enough owing to the scantiness of the material 1oft o us by time, to
secteate the ffe of the sncivnt Phoenician Zinbabwe, whose riins stll stand in Rhodesia, and, with the addition of the necessary
fove story, to suggest cizcumstances such as might have brought about or accompanied its all at the hends of the sunounding
savage tribes. The third, "Black Heart and White Heart," s a story of the courtship, tisls and final vnion of a pair of Zul oversin ¥/
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What we're now going to do is convert these into active "hyperlinks", so that clicking on a chapter title will take us to that chapter in the text. We do this using BD's "Notes and Links" facility.

Go to the "Edit" menu and select "Notes and Links". The "Notes and Links" dialog will appear, initially empty:
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The left column will contain a list of the places we want to jump to in the text – BD calls these "notes". We can then add "links", such as TOC entries, to any "note", to allow us to jump there.

The first thing we need to do is mark each chapter title in the book as a "note". Fortunately, there is a very quick and easy way to do this:

Arrange the screen so that you can see the BD window, the Notes/Links dialog, and the Element Browser window all at the same time, eg:
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Now, click, in turn, on each chapter title in the Element Browser window. This will highlight the text in the main BD window. Then click the "Add" button under the left column on the "Notes and Links" dialog. This will add the highlighted title as a "Note", showing the first few words of the title, with the page number alongside. After you've done this, the "Notes and Links" dialog should look like this:
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We now have to "link" each item in our table of contents to the appropriate note. This is a little bit fiddly, so do it carefully.

Return to the TOC at the top of the file, and carefully select the text of the first item in the contents – the words "Author's Note":
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savage tribes. The third, "Black Heart and White Heart," s a story of the courtship,tisls and final union of a paiof Zulu Iovers in

French | 42pages 2 1240





Make sure that you select only the exact words – none of the spaces before it, and not the "end of line" after it.

This text will become our "link", so go to the "Notes and Links" dialog, click on the "Author's Note" entry in the left-hand "Notes" column to select it, then click the "Add" button under the right-hand "Links"column to add the selected text as a "Link" to the chosen note.

Several things should happen:

The "Notes and Links" dialog should now show a "Link" for the selected note:
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In the main "BD" window, the text "Author's Note" should now appear as an underlined "hyperlink" and, if you hover the mouse over it, you should see a "pop-up" window appear showing you where the "jump" will take you in the final book:

Repeat this for each line in the table of contents. After you've finishes, the "Notes and Links" dialog should show a "Link" for each "Note", and all the entries on the contents page should be "active" hyperlinks:
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Step 11: Add footnotes

The final step in the formatting process is to add active hyperlinks for any footnotes that the book may have. This book does have some, marked in the text by "*". In the book as it stands, the footnotes are "inline", but it's nicer to make them "endnotes" at the end of the book, with links jumping to them. This is what we'll do.

First, go to the end of the book and add a new title: "Footnotes":

[image: image33.png]% Black Heart and White Heart

Fle Edt Fomat Insert View Go Tools Convertors Makeeooks Configuration Help

B &[0 (@ oc(¢(s] oo vk 22 @0]E e [ 23]

"Now we wil make an end," muttered Hadden savagely, end he tumed to seek the assegai, then staggered slowly back with
starting eyes and seeling gait. For there before him, still clad in her white tobe, a spearin her hand, stood the spisit of Neneal

"Think of " he seid to himself, dinly semembeting the words of the inyanga, "when you stand face to face with the ghost of the
dead in the Home of the Dead.”

There was a cry and a flash of stecl; the broad spear leapt towards him to bury itself in his breast. He swayed, he fell and.
presently Black Heart closped thet great seward which the word of the Bee had pronised Him.

"Nahoon! Nahoon!" mumuted a soft voice, "awake, it is nio ghost, but LNaneal, your living wife, to whom my Bhlose[*] has
given it me to save you"

[¥] Gruardion Spisi

Hahoon heard and apened his eyes to look and his madness 1of him.

"Welcome, wife," he said faintly, "now ] will ive since Death has brovght you back to me in the House of the Dead.”

To-day Nahoon is one of the Indunas of the English Government in Zululand, and there are children about his kraal. It was from
the fips of none other than Nanea his wife that the teller of this tale heard its substance

The Bee also lives and practises as much magic as she dares under the white mari rule. On her black hand shines a galden ring
shaped fike a snake with ruby eyes, and of this trinket the Bee is very provd.

End of Project Gutenberg's Black Heart and White Heat, by H. Rider Haggard.
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Now, return to the start of the book, bring up the "Find/Replace" dialog, and search for "*", which is what marks footnotes in this book:
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Authors Note
L Philip Hadden and King Cetywayo

IL The Bee Prophesies
IIL The End of the Hunt
IV Nanea

¥.The DoomPool

L. The Ghost of the Dead

Author's Note

Of the three stories that comprise this volume(f], one, "The Wizsrd,” a tale of victorious fath, first appeared some years ago as a
Chaistmas Anmusl. Another, "Elissa,” is an attempt, diffiult enough owing to the scantiness of the material 1t 10 us by time, to
secteate the ffe of the sncivnt Phoenician Zinbabwe, whose riins stll stand in Rhodesia, and, with the addition of the necessary
fove story, to suggest cizcumstances such as might have brought about or accompanied its all at the hends of the sunounding
savage tribes. The third, "Black Heart and White Heart," s a story of the courtship,tisls and final union of a pai of Zult Iovers in
the time of King Cetyway.

[¥] This text was prepared from a volume published in 1900 tiled "Black Heart snd White Heart, and Other Stories." JE.

1. Philip Hadden and King Cetywayo

4 the date of our introduction to hin, Philip Hadden was a transport-ider and teader in "the Zulu " Stll on the sight side of forty,
in appearance he was singularly handsome: tall, datk, upright, with keen eves, short-pointed beard, cuing hair and clear.cut
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As can be seen, the "*" in the text marks the reference, and the actual footnote is below the referenced paragraph.

What we are going to do, is to replace each [*] with a numbered reference, so the first one will be [1], the second [2], etc. Then, we'll select each footnote, cut it, scroll to the end of the book, and paste it, renumbering the footnote to match the reference. So, for this first one, we change the reference to read [1] in both the reference and the footnote, and then select the footnote:
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Authors Note
L Philip Hadden and King Cetywayo

IL The Bee Prophesies
IIL The End of the Hunt
IV Nanea
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Author's Note

Of the three stories that comprise this volume[1], one, "The Wizsrd,”  tale of victorious fath, first appeared some years ago as a
Christmas Anmual. Anothes, "Elissa" is en ltems, diffcul: enough owing io the scantiness of the material 1ot o us by time, to
secteate the ffe of the sncivnt Phoenician Zinbabwe, whose riins stll stand in Rhodesia, and, with the addition of the necessary
fove story, to suggest cizcumstances such as might have brought about or accompanied its all at the hends of the sunounding
savage tribes. The third, "Black Heart and White Heart," s a story of the courtship,tisls and final union of a pai of Zult Iovers in

1. Philip Hadden and King Cetywayo

4 the date of our introduction to hin, Philip Hadden was a transport-ider and teader in "the Zulu " Stll on the sight side of forty,
in appearance he was singularly handsome: tall, datk, upright, with keen eves, short-pointed beard, cuing hair and clear.cut
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Select "Edit/Cut" or "Ctrl+X" to cut the text, "Ctrl+End" to go to the end of the book, and "Ctrl+V" (or "Edit/Paste") to paste the footnote:
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"Think of " he seid to himself, dinly semembeting the words of the inyanga, "when you stand face to face with the ghost of the
dead in the Home of the Dead.”

There was a cry and a flash of stecl; the broad spear leapt towards him to bury itself in his breast. He swayed, he fell and.
presently Black Heart closped thet great seward which the word of the Bee had pronised Him.

"Nahoon! Nahoon!" mumuted a soft voice, "awake, it is nio ghost, but LNaneal, your living wife, to whom my Bhlose[*] has
given it me to save you"

[¥] Gruardion Spisi

Hahoon heard and apened his eyes to look and his madness 1of him.

"Welcome, wife," he said faintly, "now ] will ive since Death has brovght you back to me in the House of the Dead.”

To-day Nahoon is one of the Indunas of the English Government in Zululand, and there are children about his kraal. It was from
the fips of none other than Nanea his wife that the teller of this tale heard its substance

The Bee also lives and practises as much magic as she dares under the white mari rule. On her black hand shines a galden ring
shaped fike a snake with ruby eyes, and of this trinket the Bee is very provd.

End of Project Gutenberg's Black Heart and White Heat, by H. Rider Haggard.
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Repeat for the other footnotes. There are only three in this book, and the result is:
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"Nahoon! Nahoon!" mumuted a soft voice, "awake, it is nio ghost, but LNaneal, your living wife, to whom my Bhlose[*] has
given it me to save you"

[¥] Gruardion Spisi

Hahoon heard and apened his eyes to look and his madness 1of him.

"Welcome, wife," he said faintly, "now ] will ive since Death has brovght you back to me in the House of the Dead.”

To-day Nahoon is one of the Indunas of the English Government in Zululand, and there are children about his kraal. It was from
the fips of none other than Nanea his wife that the teller of this tale heard its substance

The Bee also lives and practises as much magic as she dares under the white mari rule. On her black hand shines a galden ring
shaped fike a snake with ruby eyes, and of this trinket the Bee is very provd.

End of roject Cutenberg' Black Heart and Whits Heart, by B| Rdsr Haggord

Foototes

[1] This text was prepared from a volume published in 1900 tiled "Black Heart and White Heart, and Other Stories."- IB
[2] Sir Theophilus Shepstone's
[2] The royal salute of the Zulus.
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Now, just as for the table of contents, we make them into active hyperlinks. Start out by adding each footnote as a "note": Make sure the "Edit Notes and Links" dialog is visible, then for each footnote, highlight the footnote number (I just highlight the number in the square brackets at the start of the footnote) and click the "Add" button beneath the "Notes" column. The result should be:
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Now we have to add the "links". Go back to the top of the book, and search for "[". You should find the first footnote reference, "[1]". Highlight the number in the brackets, select the "1" note in the left column of "Notes and Links", and click the "Add" button in the right hand "Links" column. This will add the footnote reference as a "link" to the footnote, it will show up as a hyperlink on the BD screen, and if you hover the mouse over the reference you should see the footnote text pop up in a window.

Step 12: Create your book

Well, that's it – we are finally ready to create our Sony Reader e-Book!

Firstly, make sure that you click the "Save" button to save your work – we don't want to lose it after all this! Next, click the "Sony Reader" button on the top toolbar, or go to the "Make eBooks" menu and select "Sony Reader". You'll get a dialog with three tabs. The first tab, "e-book", shows the title and author of the book – make sure these are set correctly:
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(I've added a "comma" in "Haggard, H. Rider", and the "Adventure" category in "genre".)

The second tab, "styles", shows the font settings:
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Mine are pretty much the default settings.

The third tab, "options", is the important one. I would suggest that initially you set it to match mine, shown below:
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Many of these settings are different to the default ones – eg to suppress the generated title page and insert "user" page breaks. These are the settings that work for me. I would suggest starting with my settings, and then experimenting.

Once everything is set up right, click the "make" button under "e-book" at the bottom left of the dialog. The dialog will disappear, the e-book will be created, and then the dialog will reappear.

That's it – your e-Book has been created in the path shown at the bottom of the dialog. It will also, by default, be loaded into the Connect Viewer, so you can see what it looks like there. If you've followed along with this tutorial it should look pretty good, but obviously you can experiment and see what works and what looks good.

Step 13: Save your files

This is the important bit! Ebook creation is an "iterative" process, so it's very important that you save BDs files so that you can resume your work at a later date.

BD saved all the files for the current book in a folder called "LastFile", under the "Book Designer" installation folder. If you've installed in the default location, this will be:

C:\Program Files\Book Designer 4.0"

Navigate to this folder in Windows Explorer, and copy the entire "LastFile" folder into your storage folder for the book – the folder you initially opened the book from. Then, in order to do more work on the book in the future, all you have to do is go to that "LastFile" folder and double click BD's ".html0" file that's in there.

Summary

Well, I hope that's of some use. In this document I've given a detailed description of what I do to format PG books for the Reader. You may well have a completely different idea of how to do it – please feel free to leave me a message on the "MobileRead" forums if you do!

Hope you find this useful!

Best wishes,

HarryT

